
GASWorkS™ Example Calibration

Summary

In this example, an existing model will be used to
demonstrate the process of calibrating a model against
field measured results.

For calibration we will use a “measured” field value of
6.4 Psi for Node 120, and 8.4 Psi for Node 40, a supply
pressure at Node CIG_TAP of 19.2 Psi, and total flow
into the system of 8.5 Mcfh.

Steps

The following assumes that GASWorkS has already
been started. If a model is already open, close it now
using the Close menu item from the File menu list. Use
the following procedure to work this example...

1) Open The Existing Model

! Select the Open menu item from the File menu list. A File Selection screen will be displayed. Select the
file named westdemo_90.hdr, then select the Continue command button.

! If the model is not automatically displayed, select the View/Edit menu item from the Graphics menu list
to view the model.

! Resize the image using the Maximize GDI Window command in the GDI Command List. Then zoom the
image to fill the display using the Zoom To Fit icon from the View Controls toolbar.

2) Reset The Pipe Efficiencies

Before starting a calibration it is a good idea to reset all of the pipe efficiencies to 1.0 using the Mass Update
routine.

! Select the Mass Update menu item from the Edit menu list. The Mass Update Specifications screen will
be displayed.
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! Select Pipe Efficiency from the Set list, enter 1.0 for Equal To, and select All from the Is list. The
other items may be ignored. Select the Apply command button to make the changes. A message will
appear stating the number of records updated, select the OK command button to clear the message.
Select the Close command button.

3) Determine The Design Factor

To determine the Design Factor we need to first determine the total flow into the system for a Design Factor
equal to 1.0.

! Select the Solve icon in the lower-right corner of the GDI window. The Solution Data screen will be
displayed.

! On the Solution Data tab, set the Design Factor to the previously calculated value, 1.0. Review
the other solution parameters, then select the Solve command button to solve the model. The Solution
Log will be displayed. Review the results, then select the Close command button.

! Select the Summary menu item from the Report menu list. The Summary Report Options screen will be
displayed. Select (check) the Supply Summary option. Select the Report command button. The Summary
Report will be displayed. Note the total flow being supplied by the Node CIG_TAP. It should be about 5.67
Mcfh. Select the Close command button.

! Calculate the Design Factor by dividing the measured flow (8.5 Mcfh) by the current total system flow
(5.67 Mcfh). The new design factor should be about 1.5.

4) Set The Supply Pressure

! Select the Edit Node Data icon from the Data Edit Commands toolbar. Select the Node CIG_TAP (the
most eastern node). When the Node Data screen is displayed, enter 19.2 Psi for the Pressure value. Select
the Close command button.

5) Solve The Model

! Select the Solve icon in the lower-right corner of the GDI window. The Solution Data screen will be
displayed.

! On the Solution Data tab, enter or select the following values:

Design Factor = 1.5
Review the remaining solution parameters.
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! Select the Solve command button. The Solution Log will be displayed when the solution is
complete. Review the results, then select the Close command button.

6) Review The Results

For calibration we will use a field value of 6.4 Psi for Node 120, and 8.4 Psi for Node 40. It’s best to start
the “calibration” process by reviewing the results for the node (with a measured value) closet to a supply
point with a known value. For our example, let’s look at Node 40 first and try to fit it to the field results. The
model results indicate the “new/clean pipe” values for the pressures - because the efficiency is set to 1.0.

! Find Node 40 by selecting the Find Node icon from the Data Edit Commands toolbar. For the Search
Method select Name/Number Value. For the Name of Node To Find enter 40. Click the right mouse button
or press the Enter key to end the search. A flag will be placed at the node location.

! Select the Edit Node Data icon from the Data Edit Commands toolbar, then select the Node 40 (the most
western node). When the Node Data screen is displayed, note the Pressure value - the field measured value
was 8.4 Psi. In this case, the model value is higher than the field value, indicating that the model is not
predicting enough pressure drop. Select the Close command button.

7) Adjust The Efficiency

To increase the pressure drop let’s adjust the efficiencies along the flow path between the supply point and
Node 40. We will use the Trace & Update routine to make the change.

! Select the Trace & Update command from the GDI Command List. The Trace & Update Specification
screen will be displayed. Enter or select the following settings. When finished select the Trace & Update
command button to continue.

Trace Style = Trace Upstream
Start Trace At = A Node

Select an appropriate highlight color by clicking in the color box. The Color Pallette will be
displayed. Select a color, then select the OK command button to save the change.

Select Pipe Efficiency from the Set list.
Enter 0.8 for Equal To.

! Select Node 40 (the flagged node) for the Starting Node.

! The pipes along the trace route will be highlighted. Check the highlighted pipes, if they look appropriate,
select the Yes command button to make the change. Select the OK command button to clear the message.
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8) Re-Solve The Model

! Select the Solve icon in the lower-right corner of the GDI window. The Solution Data screen will be
displayed. Review the solution parameters, then select the Solve command button. The Solution Log will be
displayed. Review the results, then select the Close command button.

9) Review The Results

! Check the new pressure value for Node 40. If the new value is less than the field value, the pressure drop
is now too great, meaning that our efficiency value is too small - increase the efficiency value to increase the
pressure value. If the new value is higher than the field value, the pressure drop is now too small meaning
that our efficiency value is too large - decrease the efficiency value to decrease the pressure value.

! Continue the process of adjusting the efficiency, solving the model, and reviewing the results until the
model and field pressures match within an acceptable tolerance (about 0.1 Psi for this example). The final
efficiency for the pipes feeding Node 40 should be about 0.83.

! After matching the value at Node 40, check the value at Node 120. Adjust the efficiency of the pipes along
the flow path feeding that node until an acceptable match is reached.

10) Check The Pressure At Node 120

! Use the Edit Node Data command from the GDI Command List to check the pressure at Node 120. In this
case the model value is higher than the field value. This indicates that the pressure drop along the flow path
to that point needs to be increased.

11) Adjust The Pipe Efficiency To Node 120

To increase the pressure drop along the pipes feeding Node 120, let’s adjust the efficiencies along the flow
path to the node, but not for the pipes that we have already adjusted. We will use the Edit Multiple Pipes
routine to make the change

! Select the Edit Multiple Pipes icon from the Data Edit Commands toolbar. Select the pipes along the flow
path supplying Node 120 by placing the mouse pointer near the pipe and pressing the left mouse button. The
pipes will be highlighted when they are selected. When all of the desired pipes have been selected, press the
right mouse button. The Multiple Edit Specifications screen will be displayed.

! Select Pipe Efficiency from the Set list. Let’s try 0.8 for our first guess. Enter 0.8 for the Equal
To value. Select the Apply command button to make the change. Select the OK command button to
clear the message. Select the Close command button after the change has been made.
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! Continue to adjust the efficiencies, re-solve, and review the results until the pressures are within 0.1 Psi
or so. You will find that the efficiency needs to be set relatively low (about 0.45) to make a match. This could
indicate a problem with the measurement, a problem with the data, or an operational problem with the
system.

Notes & Considerations

! In distribution systems, generally only a few values are known compared to the total number of nodes.
Discretion and judgment often play as big of a role in the calibration as the actual field values. In other
words, do the calculated values look right? If they don't, they probably aren't.

! When calibrating a model, consideration should be given to the accuracy of the field measurements. For
example, were the values measured or estimated, were the values taken from a gauge that was only marked
in five pound increments, were the values taken from a chart with a fat pen, when was the instrument last
calibrated?

! Ideally, the measurements need to correspond to the exact same point in time. In other words, the
measurements need to have all been recorded at the same exact time. In distribution systems, where the flow
(and consequently the pressure) changes from hour-to-hour and day-to-day, it is very critical that the
measurements be taken at the same time.

! In this example, we assumed that the gas properties and flowing temperatures were valid for the calibration
period. It is common practice to use average values for normal design and analysis, however using average
values during the calibration process can skew and corrupt the calibration results. When performing a
calibration use the most accurate data that you have available. Obtain a gas analysis taken near the time the
calibration data was taken. Calculate the gas properties associated with the analysis and use these during the
calibration.

! Additionally, collect and use temperature values corresponding to the calibration period. Often temperature
data can be obtained from measurement data collected at meter stations. However, be careful when using
temperatures measured downstream of regulator and compressor stations. The temperature immediately
downstream of a regulator will always be lower than the average upstream and downstream gas temperatures.
Conversely, the temperature immediately downstream of compressors will almost always be higher than the
average upstream and downstream temperatures.

! For best results, the calibration data should correspond to a peak flow period. It is impossible to calibrate
a system that has little or no pressure drop. The higher the pressure drop across the system, the more accurate
the calibration results will be.
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! Why don't the model results match the field data values exactly? First, remember that the "model" is just
that - it is a model or a scaled representation of the actual system. There are a lot of things that are not known
very accurately about the actual system, and there are a lot of things that are not being specifically included
in the model. Items not specifically addressed by the model include such items as the affect of taps and pipe
joining methods. Unknown items include debris or liquids in the pipe, incorrect pipe sizes, incorrect or
inaccurate wall thickness values, crimped, crushed, or dented pipe segments, unusual connections, inaccurate
length values - the list goes on and on...

! Ideally, once the pipe efficiencies have been calculated along the flow paths to the known pressure
locations, an average efficiency could be calculated and applied to the remaining pipes. In this case the
efficiency values required to match the measured pressures at Node 120 was comparatively low, which would
generally indicate a problem with either the measured value, with the model data, or could indicate an
unusual restriction in the piping system - a partially closed valve, a pinched or partially collapsed main, or
maybe debris or liquid in the system. Averaging the efficiency values found in this example would probably
not be wise.

! It is absolutely critical that a model be calibrated before it is used as the basis for any decision making. As
shown by this example, the calibration process is time consuming. However, usually the reason a model is
created is because some sort of decision needs to made. Decisions involving system modifications or system
capacity can be quite costly to implement and even more costly to fix after a bad decision has been made.
Spending a bit of time calibrating the model to ensure that it is providing accurate results, will nearly always
save you time, money, and most of all headaches later.
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